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IBM Infoprint Manager for Windows Version 2.1.0 README

This readme contains the following information:

“General Release Notes for Infoprint Manager for Windows"l contains topics that
apply to Infoprint Manager for Windows in general. When this information
changes, it will be marked with revision bars ( | ) in the left margin.

“Release Notes for Version 2.1.0 PTF UR54088 (December 2003)”” on page 2|
contains topics that apply to this Version 2 Release 1 service update.

. |“Re|ease notes for Version 2.1.0 PTF UR53923 (April 2003)” on page 4|c0ntains
topics that apply to this Version 2 Release 1 service update.

“Release notes for Version 2.1.0 PTF UR53740 (November 2002)” on page 4|
contains topics that apply to this Version 2 Release 1 service update.

+ |“Release notes for Version 2.1.0 PTF UR53705 (August 2002)” on page 6 contains
topics that apply to this Version 2 Release 1 service update.

« |“Release notes for the Version 2.1 NLV Refresh” on page 6| contains release notes
that apply to the Version 2 Release 1 National Language Version (NLV) code.

+ [“Release notes for Version 2.1” on page 7| contains release notes that apply to the
Version 2 Release 1 code.

General Release Notes for Infoprint Manager for Windows
Information on the following topics was removed from this README because it is
now available in the Infoprint Manager for Windows: Getting Started manual.
» Server software prerequisites
 Installing and uninstalling Infoprint Manager for Windows service updates
» Before and after migrating to Infoprint Manager Version 2.1
* Migrating optional features

Note: "Customizing error logs in the Infoprint Manager server” has been added to
the IBM Infoprint Manager: Update Guide for PTF U483536 and PTF UR54088.

Backing up the Userlnit file for the PostScript transform
program

If you have modified the Userlnit file for the ps2afp transform, you must create a
backup copy of the file prior to installing a service update or new version of
Infoprint Manager for Windows. If you do not perform this task, the install
program provided with Infoprint Manager for Windows overwrites the existing
Userlnit file, removing all prior changes to that file.

Infoprint Manager for Windows installs the UserlInit file into the following
locations:

1. install_path\var\psf\ps2afp
2. install_path\var\psf\ps2afp2

Possible issues when completing Infoprint Manager for
Windows Server 2.1.0 install

When installing the Infoprint Manager for Windows server CD-ROM, you might
receive the Wrong Volume pop-up error message:
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The wrong volume is in the drive. Please insert volume IPM_410A_NTS1
into drive D:

where D: is the CD-ROM drive on your Windows server.

If this occurs, follow the directions and reinsert the base server CD-ROM to
complete the install successfully.

Accessing the Publications CD-ROM

Use the following procedure to access the publications CD-ROM:

1. Insert the Publications CD-ROM in your CD-ROM drive. It starts automatically.

2. From the pulldowns for all choices, select Open the collection index.

3. Click OK.

4. Because this change does not take effect until you re-insert the CD-ROM, open
the CD-ROM drive and then close it.

5. The CD-ROM now opens to the opening page of the publications in pdf
format.

6. Scroll down the list of publications, and select the one you want to view.

Viewing the Publications CD-ROM

The contents of the publications CD are best viewed using Netscape Navigator
Version 4.7 or higher, or Internet Explorer Version 5.0 or higher. Adobe Acrobat
Reader Version 3.0 can be used to view most PDF files on the CD; however, for
larger files, such as the Infoprint Manager: Reference, Acrobat Reader Version 4.0
or higher is required. To download Acrobat Reader, visit the Adobe web site at
http://www.adobe.com.

Release Notes for Version 2.1.0 PTF UR54088 (December 2003)

PTF UR54088 (APAR IR51331) contains several enhancements to function, usability,
and reliability. Refer to the "Functional Enhancements” section for more
information. For a summary of the fixes provided with this PTF, refer to the
Service Page of the Infoprint Manager for Windows 2.1 Web site at
http://www.printers.ibm.com/R5PSC.NSF/Web/ipw210ser. To apply this service
update, refer to the Infoprint Manager for Windows: Getting Started manual.

Infoprint Manager documentation updates
With this service update, you will notice the following changes:

* The IBM Infoprint Manager: Update Guide for PTF U483536 and PTF UR54088
contains information describing fixes and product enhancements available with
these service updates for both Infoprint Manager for AIX Version 4 Release 1
and Infoprint Manager for Windows Version 2 Release 1.

Note: Earlier versions of some information are published in the currently
available Infoprint Manager library manuals.

* The Infoprint Manager: SAP R/3 Planning and Configuration Guide, (S544-5902) has
been updated and has a publication number.

Functional enhancements

The following enhancements in function and usability are available with the
December 2003 Infoprint Manager for Windows PTF:

» Support for printing with Microsoft Unicode Open Type Fonts through Infoprint
Manager.
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» Support through the img2afp transform for printing FS45 Image Object Content

Architecture (IOCA) images as high-quality FS10 IOCA images on
black-and-white printers.

Support for an IBM Infoprint Manager Linux client to enable users of Linux on
intel-based servers to issue Infoprint commands over a TCP/IP-connected
network to an Infoprint Manager Windows server.

Support for using the following new printers with Infoprint Manager:
— Infoprint 1222

— Infoprint 1226

— Infoprint 1312

— Infoprint 1232

— Infoprint 1352

— Infoprint Color 1354

— Infoprint Color 1357

— Infoprint 1372

— Infoprint 2060ES, Infoprint 2075ES, Infoprint 2090ES, and Infoprint 2105ES are
new Workgroup printers that provide significant finishing options, such as a
booklet-maker, a post-fuser insertion, and the ability to print to a document
server (DASD).

The number of Distributed Print Function (DPF) host receivers that can exist at
one time has been increased to 100.

Five new PPD files have been added to Infoprint Select in order to allow you to
specify Infoprint attributes for finishing when printing to the following printers
as either TCP/IP or Channel DSSs:

— IBM Infoprint 4100

— IBM Infoprint 2060ES
— IBM Infoprint 2075ES
— IBM Infoprint 2090ES
— IBM Infoprint 2105ES

Infoprint Manager now supports printing the following AFP bar codes for
customers with printers that support and applications that can generate:

- OR Code

Code 93

EAN 128 BarCode

— Australian Postal BarCode

The Infoprint Manager SAP Clients install has been enhanced to allow users to
turn graphics content object architecture (GOCA) support on or off on all client
platforms.

The transform subsystem has been enhanced to allow:
— Passing job, document and actual destination attributes to the transform

— The transform to update the job’s job-page-count and pages-completed
attributes.

— The creation of conditional terminating transforms that can be useful when
passing information to other applications.

Support through the ps2afp transform for both staple and punch support.

This support is limited to PostScript printers like the IBM Infoprint 2060ES and
IBM Infoprint 2075ES that have PostScript drivers that support this function.
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Release notes for Version 2.1.0 PTF UR53923 (April 2003)

PTF UR53923 (APAR IR50128) contains several enhancements to function, usability,
and reliability. Refer to the "Functional Enhancements” section for more
information. For a summary of the fixes provided with this PTF, refer to the
Service Page of the Infoprint Manager for Windows 2.1 Web site at
http://www.printers.ibm.com/R5PSC.NSF/Web/ipw210ser. To apply this service
update, refer to thelnfoprint Manager for Windows: Getting Started manual.

Number of error logs expanded

If you apply PTF U53923, the default number of error logs retained for your
Infoprint Manager server, Notification server, and SAP Callback processes increases
from one to ten. You can increase or decrease the number of error logs that
Infoprint Manager saves, but will need to follow the directions provided in
"Customizing error logs in the Infoprint Manager server” in Infoprint Manager for
Windows: Procedures.

Enhanced performance of Infoprint Manager Server in a

distributed environment

A distributed environment consists of many Infoprint actual destinations for each
print queue. As a general rule, as the number of jobs in a queue or the number of
actual destinations on a queue grows, job throughput can slow. Infoprint Manager
server (pdserver) has been enhanced in PTF UR93523 so that it processes jobs more
quickly in a distributed environment if the jobs have a value for the
actual-destinations-requested job attribute.

Functional enhancements

The following enhancements in function and usability are available with the April
2003 Infoprint Manager for Windows PTF:

* Hot folder job support no longer requires you to use staging for single
document large files.

* The Infoprint Manager GUI now releases jobs in the order they are displayed.

* You can now submit rip and hold jobs to a PSF printer that uses a transform
object, and the results will be the same as with other rip-and-hold jobs.

* You can now customize Infoprint Manager server error logs to save the number
of backup logs you define for your installation.

Release notes for Version 2.1.0 PTF UR53740 (November 2002)

PTF UR53740 (APAR IR48858) contains several enhancements to function, usability,
and reliability. Refer to the "Functional Enhancements” section for more
information. For a summary of the fixes provided with this PTF, refer to the
Service Page of the Infoprint Manager for Windows 2.1 Website at
http://www.printers.ibm.com/R5PSC.NSF/Web/ipw210ser. To apply this service
update, refer to the Infoprint Manager for Windows: Getting Started manual.

Job contextual menu on Administration and Operations GUIs

may not be fully visible

Due to a problem with the Java implementation tools, there may be cases when the
job contextual menu displays beyond the bottom of the display screen when
selected from the Administration GUI or the Operations GUI. You must manually
move the menu up in order to see the entire display.
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Selecting enhanced or standard Infoprint Select

Once you have successfully installed Infoprint Select, you must determine whether
or not you want the enhanced version of the client that is available with PTF
UR53740. If you use the enhanced Select, users can enter job and document
attributes with print jobs if the printer they send the job to is a Select printer. You
may decide not to provide this ability to end users since it requires an
understanding of how to use attributes. For more information on the enhanced
Select and specifying attributes, refer to the Infoprint Manager for Windows: Getting
Started manual.

Note that if you use Infoprint Select in a language other than English, the
enhanced version is not available at this time.

If you want to apply the enhanced Infoprint Select, perform the following action:

Click the Start button on your Windows system and select Programs » Infoprint
Select » Activate attributes dialog.

This action ensures that you can access the new dialog panels that allow you to
specify Infoprint job attributes when submitting a job to the server, as well as
cancelling, holding, and releasing jobs within a queue from the Infoprint Select
client.

Functional enhancements

The following enhancements in function and usability are available with the
November 2002 Infoprint Manager for Windows PTF:

» Support for the IBM Infoprint 4100 HS2 high quality simplex and IBM Infoprint
4100 HD23/HD4 high quality duplex model printers

» Support for the IBM Infoprint 4345 printer

* Infoprint Manager extends its existing SAP Output Management Support (OMS
Callback) to the Infoprint Manager for Windows platform. This support allows
you to closely integrate an external output management system, like Infoprint
Manager for Windows, with an SAP System. Infoprint Manager for Windows
SAP OMS support allows your SAP users to receive notifications for the jobs
that they have submitted to print or fax. It also provides users to cancel or query
the status of their jobs and to query the status of the device.

» Enhancements to the SAP Client including:

— Sending jobs to multiple Infoprint Manager systems from the same SAP
system

— Switching the Infoprint Manager server that your SAP system is sending
commands to

— Allowing you to define backup Infoprint Manager servers.

Note: For particulars about installing and using this new support, refer to the
latest Infoprint Manager: SAP R/3 Planning and Configuration Guide,
(S544-5902), which is available from the Infoprint Manager for Windows
2.1: Product Library page at
http://www.printers.ibm.com/R5PSC.NSF/Web/ipmrefinfo2l.

* Enhancements to Infoprint Select including:

— the ability to set and send Infoprint attributes along with the job

— access to print queue and jobs that are located on the Infoprint Manager

server
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— faster filtering when configuring an Infoprint Select printer

* Enhancements to the Install Shield Multi-Platform packaging software used to
install much of Infoprint Manager

» Functional and usability enhancements in the Administration and Operations
GUIs

— Addition of the job pause (job » pause) action
— Addition of the job resume (job » resume) action

— Addition of the interrupt printing job (Printer » Interrupt Printing Job...)
action

Provides the equivalent function of the following command through the GUI:
pdpause -j destination_name
— Addition of an option not to display retained jobs in the GUIs main window
— Improved GUI response time with large numbers (800-1200) of retained jobs

» Hold processing job support has been enhanced to cancel the job on the printer,
resulting in improved server performance

* New calibration curves for IBM Infoprint 4000 and IBM Infoprint 4100 printers
to support Version 3 Toner

» Support for Korean Output Text Format (OTF) and Advanced Business
Application Programming (ABAP) data streams in the SAP transform

» Support for AFP Font Collection Version 3 through font mapping tables that
apply to all AFCCU and Workgroup printers

» Support for media selection by name rather than bin number with printers that
support this feature

» Support for the finishing fidelity through the AFP Finishing Fidelity triplet that
provides compatibility with OS/390

» Support for UP3i post-processing through extensions that are available from the
latest level of Page Printer Formatting Aid

* All documentation has been updated and is available from the Infoprint
Manager for Windows Version 2.1 Product Library page at
http://www.printers.ibm.com/R5PSC.NSF/Web/ipmrefinfo2l.

After December 20, 2002, visit the Printing Systems Information Center at
http://publib.boulder.ibm.com/printer/psindex.htm.

While minor changes were made to the man pages, they were not included in
the product build. For the most current information on mvsprsd, pdmod, pdset,
pcl2afpd, pcl2afp, ps2afp, and pdf2afp, refer to the appropriate sections of the
Infoprint Manager: Reference.

Release notes for Version 2.1.0 PTF UR53705 (August 2002)

Note that PTF UR53705 (APAR IR48548) contains no new functional enhancements.
For a summary of the fixes provided with this PTF, refer to the Service Page of the
Infoprint Manager for Windows 2.1 Web site at
http://www.printers.ibm.com/R5PSC.NSF/Web/ipw210ser. To apply this service
update, refer to the Infoprint Manager for Windows: Getting Started manual.

Release notes for the Version 2.1 NLV Refresh

Please note that information on the following topics was removed from this
README because it is how available in the current publications:
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Running Infoprint Manager in double-byte languages
Now available in the Infoprint Manager for Windows: Getting Started book in
Chapter 4.

Downloading AFP print drivers from the IBM web site
Now available in the Infoprint Manager for Windows: Getting Started book in
Chapter 20.

Adding forms in the Infoprint Manager Administration GUI

When you add a form in the GUI, it only shows up in the list of available forms
after a job has been run with that specific form. For example, if you associate the
form Letter with Job 1, Letter will not display in the Printer » Change Forms or
Job » Change Forms drop-down lists until after Job 1 has completed.

Japanese Common Client CD "Contact Us” title garbled

On the Japanese NLV version of the Common Client CD, the title of the "Contact
Us” page is not translated, and contains garbled English characters. This will be
fixed in a future update of the Common Client CD.

Release notes for Version 2.1

Please note that information on the following topics was removed from this
README because it is now available in the current publications:

Close Infoprint Manager Administration GUI, Operations GUI, and
Management Console before installing any PTF or re-installing Infoprint
Manager
Now available in the Infoprint Manager for Windows: Getting Started book in
Chapter 4.

Ensure that the Infoprint Manager server and the Administration and
Operations GUI are at the same level
Now available in the Infoprint Manager for Windows: Getting Started book in
Chapter 4.

Power on a destination before creating as an actual destination
Now available in the Infoprint Manager for Windows: Getting Started book in
Chapter 9.

Whenever possible, load print drivers on the server for each client operating
system
Now available in the Infoprint Manager for Windows: Getting Started book in
Chapter 16.

Notification method "exit” cannot run a program that requires a window
Now available in the Infoprint Manager for Windows: Procedures book in
Chapter 7.

Setting up finishing options for the Infoprint 2085 and Infoprint 2105
Now available in the Infoprint Manager for Windows: Procedures book in
Chapter 26.

Verifying configuration with SecureWay Communications
Server

If you use PSF Direct to print from host systems, you must also install IBM
SecureWay Communications Server for Windows NT at Version 6.01 with required
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APARs JR13453, JR13599, and JR14098 or IBM SecureWay Communications Server
for Windows 2000 at Version 6.1. (Host systems include MVS, VSE, VM, and
0S/400.)

Currently with Version 6.1, there is an error with configuration verification with
SecureWay Communications Server. To correct this error, use the following
procedure:

1. Go to Start » Programs » IBM Communications Server » Configuration
Verification.

2. Go to File » Open... and select the controllername.acg file that you want to
verify, where controllername is the name you gave the configuration file.

3. Click on the Checkmark icon and a message similar to the following is
displayed:
Verifying...
PCS7210E The value NN for keyword
/LOCAL_LU[LU_NAME=PSFDCFLU]/DEFAULT POOL/ is not valid.
Verify ended with errors.

4. Click on the Pencil icon and locate the line that contains LOCAL_LU= and change
the DEFAULT_POOL=NN to 0 (zero), where NN is the number reported in the
message in Step 3.

5. Go to File » Exit and click Yes when prompted to save the controllername.acg
file.

6. Reverify the controllername.acg file again by clicking on the Checkmark icon.
The following message is displayed:

Verifying...
Verify complete with no errors.

Notes:

1. Preliminary testing has been completed with IBM SecureWay Communications
Server, Version 6.1, and Infoprint Manager for Windows. However, the PSF
Direct Network Configuration Guide that is available on our Web site and
publications CD-ROM was developed and tested using Version 6.01. Minor
differences exist between the two versions, and these differences will be tested
and documented in the future.

2. If you need to uninstall IBM SecureWay Communications Server, you should
uninstall Personal Communications first. However, if you have installed APAR
JR14481, the uninstall process informs you of this situation.

Setting the TCP KEEPALIVE frequencies (for customers using
Download for OS/390 or DPF)

Because network objects, such as printers, are sometimes terminated abruptly (for
example, powered off), it is advisable to use a periodic poll that enables TCP to
discover when a connection is no longer usable. This periodic polling is called the
KEEPALIVE frequency.

The frequency of these KEEPALIVE transmissions is determined by system-wide
TCP/IP configuration parameters in the host(s). You should set the KEEPALIVE
interval, as described in the instructions for your particular type of host, to be
much smaller (for example, four minutes), to maintain the network connection.
This allows the system to detect if a printer has been powered off or is no longer
accessible to the network.
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Manually running fontmap.cmd on new Windows systems

During configuration, a file called fonts.map is created. This file is used by the
PostScript and PDF transforms. In cases where the install of Infoprint Manager is
done on a new Windows system, it is possible for this file to be created with a size
of 0 bytes. If this happens, the transforms will fail. To solve this problem, from a
Command Prompt navigate to the install_path\PS folder and enter this command
to run the font command script: fontmap.cmd.

While this script is running, it is checking for the fonts installed on your system,
and you may see messages on the screen indicating fonts that are not installed.
These are not error messages, and you can ignore them.

How to access Font Downloader Feature user’s guide

On the Infoprint Manager for Windows Font Downloader Feature CD-ROM, access
the User’s Guide by viewing the CD-ROM contents and clicking on
"usersguide.pdf”’. You must have Adobe Acrobat Reader to view this file.

Limitations, restrictions, and pre-reqs

Install Generic Windows Driver before setting up Passthrough

destinations
Before configuring any Passthrough destinations, you must install the Generic/Text

Only Driver from your Windows CD.

Windows Gateway Printer considerations for mixed Windows

NT/2000 client and server
If a Windows 2000 machine is being used as an Infoprint Manager client and a

Windows NT 4.0 machine is being used as an Infoprint Manager Server, be aware
of the following situation:

A Windows Gateway Printer is created on the Windows NT server machine using
Windows NT AFP drivers. That Windows Gateway Printer is then added to the
Windows 2000 Client machine using the Add Printer wizard. Behind the scenes,
Windows tries to load the Windows NT AFP drivers onto the Windows 2000
machine and the Windows 2000 machine crashes. Do not do this.

Patience when launching the Operations or Administration GUI
When you install the Infoprint Manager Server, or install the GUIs from the client
CD, one icon will appear for the Operations GUI and one for the Administration
GUI. When you double click either of these desktop icons, a "splash” screen will
appear, and there may be a delay before the GUI screen appears. Do not double
click the icon again as this will launch a second instance of the GUI.

JRE required to uninstall GUIs

The Infoprint Manager for Windows: Getting Started manual mentions in several
places the process for uninstalling the JRE or Infoprint Manager Administrator and
Operator GUIs. If you uninstall the JRE first, the GUIs cannot be uninstalled since
the uninstall process for the GUIs is a Java uninstall process that requires a version
of JRE to run. If you want to uninstall both the JRE and the GUIs, make sure you
uninstall the GUIs first.

Infoprint Select and the Infoprint Generic Driver

When a user installs Infoprint Select on a client machine from the Common Clients
CD-ROM, the Infoprint Generic Driver is also installed on their Windows machine.
This Infoprint Generic PostScript Driver can be used when the user creates a Select
printer on their client machine. When a job is sent to the Select printer that uses
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this driver, the driver sets some job attributes that allow the job to be printed on a
PSF actual destination only. The Infoprint Generic Driver should be used only if
the Select printer is configured to point to a PSF destination. An alternate driver
for the Select printer should be used if the Select printer is configured to point to
another type of printer.

Installing and uninstalling requires administrative privilege
You must have Administrative Privilege to install or uninstall IBM Infoprint

Manager for Windows. If you try to uninstall the product without administrative
privilege, the following message is issued:

Setup Installation Error: Setup has detected Uninstallshield is in use,
please close Uninstallshield and restart setup (Error 432).

A similar message is issued at install if you do not have administrative privilege.

Ensure that you have Administrative Privilege before attempting to install or
uninstall IBM Infoprint Manager for Windows.

Remember to reboot at end of installation

After you have installed IBM Infoprint Manager for Windows, the installation
program asks if you want to reboot your system. The default answer to this
question is Yes because Infoprint Manager will not function properly until the
system is rebooted. When you click OK or press Enter, your system reboots.

Stop and restart server after prolonged server activity

Due to known limitations involving prolonged server activity, it is strongly
recommended that the Infoprint Manager Server be stopped and restarted every
seven (7) days to avoid potential problems that could disrupt server processing.

To stop and restart the server:

1. Disable all actual destinations with the Infoprint Administration or Operations
graphical user GUI.

Wait for all currently printing jobs to finish.
Stop the Infoprint Manager Server through the Management Console.
Restart the Infoprint Manager Server through the Management Console.

Re-enable all actual destinations through the Administration or Operations
GUL.

a s~ N

Functional enhancements

The following enhancements in function and usability are available with the
November 2002 Infoprint Manager for Windows PTF:

» Support for the IBM Infoprint 4100 HS2 high quality simplex and IBM Infoprint
4100 HD23/HD4 high quality duplex model printers

» Support for the IBM Infoprint 4345 printer

* Infoprint Manager extends its existing SAP Output Management Support (OMS
Callback) to the Infoprint Manager for Windows platform. This support allows
you to closely integrate an external output management system, like Infoprint
Manager for Windows, with an SAP System. Infoprint Manager for Windows
SAP OMS support allows your SAP users to receive notifications for the jobs
that they have submitted to print or fax. It also provides users to cancel or query
the status of their jobs and to query the status of the device.

* Enhancements to the SAP Client including:

— Sending jobs to multiple Infoprint Manager systems from the same SAP
system
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— Switching the Infoprint Manager server that your SAP system is sending
commands to

— Allowing you to define backup Infoprint Manager servers.

Note: For particulars about installing and using this new support, refer to the
latest Infoprint Manager: SAP R/3 Planning and Configuration Guide,
(S544-5902), which is available from the Infoprint Manager for Windows
2.1: Product Library page at
http://www.printers.ibm.com/R5PSC.NSF/Web/ipmrefinfo2l.

Enhancements to Infoprint Select including:
— the ability to set and send Infoprint attributes along with the job

— access to print queue and jobs that are located on the Infoprint Manager
server

— faster filtering when configuring an Infoprint Select printer

Enhancements to the Install Shield Multi-Platform packaging software used to
install much of Infoprint Manager

Functional and usability enhancements in the Administration and Operations
GUIs

— Addition of the job pause (job » pause) action
— Addition of the job resume (job » resume) action

— Addition of the interrupt printing job (Printer » Interrupt Printing Job...)
action

Provides the equivalent function of the following command through the GUI:
pdpause -j destination_name
— Addition of an option not to display retained jobs in the GUIs main window
— Improved GUI response time with large numbers (800-1200) of retained jobs

Hold processing job support has been enhanced to cancel the job on the printer,
resulting in improved server performance

New calibration curves for IBM Infoprint 4000 and IBM Infoprint 4100 printers
to support Version 3 Toner

Support for Korean Output Text Format (OTF) and Advanced Business
Application Programming (ABAP) data streams in the SAP transform

Support for AFP Font Collection Version 3 through font mapping tables that
apply to all AFCCU and Workgroup printers

Support for media selection by name rather than bin number with printers that
support this feature

Support for the finishing fidelity through the AFP Finishing Fidelity triplet that
provides compatibility with OS/390

Support for UP3i post-processing through extensions that are available from the
latest level of Page Printer Formatting Aid

All documentation has been updated and is available from the Infoprint
Manager for Windows Version 2.1 Product Library page at
http://www.printers.ibm.com/R5PSC.NSF/Web/ipmrefinfo2l.

After December 20, 2002, visit the Printing Systems Information Center at
http://publib.boulder.ibm.com/printer/psindex.htm.

While minor changes were made to the man pages, they were not included in
the product build. For the most current information on mvsprsd, pdmod, pdset,
pcl2afpd, pcl2afp, ps2afp, and pdf2afp, refer to the appropriate sections of the
Infoprint Manager: Reference.
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